Austin Peay State University, Tennessee Spring 2015
CSCI 3300: Introduction to Web Development
Dr. Leong Lee

CSCI 3300 Assignment 4

Total estimated time for this assignment: 7 hours

When you see “Richard Ricardo” in the example screen captures, change it to <your name>.

When you see “Richard” in the example screen captures, change it to <your first name>.

If you do not put <your name>/ <your first name> in the above mentioned fields, you will get 0 points for
the question(s).

No two students should submit webpages with exactly the same code, or same content, or same layout, or
same color combination. If found, both students will get 0 points.

Create a folder on your hard disk, name the folder lastname_firstname_assignment4. Save all the files from
this assignment in this folder.

Create the following subfolders (in the folder lastname_firstname_assignment4): g1, g2, g3.
As a result, you should have the following folder (directory) structure for this assignment:

o lastname_firstname_assignment4\q1\

o lastname_firstname_assignment4\q2\

o lastname_firstname_assignment4\q3\

Use Firefox Web Console (Tools > Web Developer > Web Console) to help debugging JavaScript. All html
(JavaScript) files must pass JavaScript validation at Firefox Web Console without any error, without any
warning (-2 points for each error, each warning).

Turn on your Firefox Menu Bar (Hint: right-click).

Make sure your Firefox is up to date (Help > About Firefox).

Turn on Web Console when you code (Tools > Web Developer > Web Console).

Fix any error/warning immediately when you see them. Do NOT accumulate errors.

When you view page source in a web browser, <!DOCTYPE html> must be at the top of every page. In
other words, all pages must be written in HTMLS5. (-20 points if not)
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Question 1 — JavaScript Chapter 3 (30 points) Estimated time: 2 hours
e Save question 1 files in subfolder “lastname_firstname_assignment4\q1\”.
e Create a web page that displays the default information (example shown).
e The initial page and related outputs should look like the examples shown below.
e Create your page using “<your name>’s Kung Fu Panda Po Power Level” as the page title. Save the page
as index.htm. Remember to document the html file with html comments.
Prompt the user to enter a number representing Kung Fu Panda Po's power level.
e The power level conversions are as follows:
o less than 0: Po eats too much pho
0 to 10: Po protects the valley of peace
11 to 20: Po defeats wolf bandits
21 to 30: Po reaches Gongmen City
31 to 40: Po destroys the tower and an arsenal of cannons
o Greater than 40: Po defeats Lord Shen
e Create a css file named style.css to format index.htm by creating your own layout (no two students should
have the same layout). Use css comments to document the css program. Y ou can use the same (or similar)
css file(s) to format all questions.

O O O O

Example: Initial Page

Richard Ricardo's Kung Fu Panda
Po Power Level

This page will prompt Richard Ricardo for Kung Fu Panda Po's power level (in number). The
program will convert the given input into Po's power metric.

less than 0: Po eats too much pho

0 to 10: Po protects the valley of peace

11 to 20: Po defeats wolf bandits

21 to 30: Po reaches Gongmen City

31 to 40: Po destroys the tower and an arsenal of cannons
Greater than 40: Po defeats Lord Shen

Click on the button below to enter Po's power level.

Enter Richard's Po power level

Po's Power:
Po's current power level
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Example: Input gqla

Enter po’s power level:

[l

Example: Output gla

Richard Rical
Po Power Level

This page will prompt Richard Ricardo for Kung Fu Panda Po's power level (in number). The
program will convert the given input into Po's power metric.

less than 0: Po eats too much pho

0 to 10: Po protects the valley of peace

11 to 20: Po defeats wolf bandits

21 to 30: Po reaches Gongmen City

31 to 40: Po destroys the tower and an arsenal of cannons
Greater than 40: Po defeats Lord Shen

Click on the button below to enter Po's power level.

| Enter Richard's Po power level |

Po's Power:
Po's power level is -15.
Po eats too much pho.
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Example: Input qlb

Enter po's power level:

(2

Example: Output g1b

Richard Rical
Po Power Level

This page will prompt Richard Ricardo for Kung Fu Panda Po's power level (in number). The
program will convert the given input into Po's power metric.

less than 0: Po eats too much pho

0 to 10: Po protects the valley of peace

11 to 20: Po defeats wolf bandits

21 to 30: Po reaches Gongmen City

31 to 40: Po destroys the tower and an arsenal of cannons
Greater than 40: Po defeats Lord Shen

Click on the button below to enter Po's power level.

| Enter Richard's Po power level |

Po's Power:
Po’'s power level is 25.
Po reaches Gongmen City.
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Question 2 — JavaScript Chapter 3 (35 points) Estimated time: 2 hours

Save question 2 files in subfolder “lastname_firstname_assignment4\q2\”.
Create a web page that displays the default information (example shown).
The initial page and related outputs should look like the examples shown below.
Create your page using “<your name>’s Kung Fu Panda Po Body Mass Index” as the page title. Save the
page as index.htm. Remember to document the html file with html comments.
Write a program that calculates and displays Kung Fu Panda Po’s body mass index (BMI). Po’s BMI is
calculated with the following formula:

o BMI =weight x 703 / height?

o Weight is in pounds, and height is in inches
The program should also indicate if Po has optimal weight, is underweight, is overweight, or is obese.

o IfPo's BMI is less than 18. Po is underweight

o If Po's BMI is between 18 and 24.9. Po has normal weight

o IfPo's BMI is between 25 and 29.9. Po is overweight

o If Po's BMI is greater than 30. Po is obese
Note: The BMI reading is not for humans. It is modified for Po. Please do not use it for humans.
Hint: You may use toFixed () JavaScript method to display a number with the exact number of
decimals.
Create a css file named style.css to format index.htm by creating your own layout (no two students should
have the same layout). Use css comments to document the css program.

Example: Initial Page

Richard Ricardo’'s Kung Fu Panda
Po Body Mass Index

This page will prompt Richard Ricardo for Kung Fu Panda Po's weight and height. The
program will convert the given input into Po's body mass index, and will inform Richard is Po
is overweight or underweight.

BMI = weight x 703 / height?

Weight in pounds. Height in inches.

If Po's BMI is less than 18. Po is underweight

If Po's BMI is between 18 and 24.9. Po has normal weight
If Po's BMI is between 25 and 29.9. Po is overweight

If Po's BMI is greater than 30. Po is obese

Click on the button below to enter Po's weight and
height.

Enter Richard's Po weight and height

Po’'s BMI:
Po's current Body Mass Index
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Example: Input g2a

Enter po's height

60] |

Enter po's weight

[ Prevent this page from creating additional dialogs.

OK Cancel

Example: Output g2a

Richard Ricardo
Po Body Mass Ir

This page will prompt Richard Ricardo for Kung Fu Panda Po's weight and height. The
program will convert the given input into Po's body mass index, and will inform Richard is Po
is overweight or underweight.

BMI = weight x 703 / height?

Weight in pounds. Height in inches.

If Po's BMI is less than 18. Po is underweight

If Po's BMI is between 18 and 24.9. Po has normal weight
If Po's BMI is between 25 and 29.9. Po is overweight

If Po's BMI is greater than 30. Po is obese

Click on the button below to enter Po's weight and
height.

‘ Enter Richard's Po weight and height

Po's BMI:

Po’s weight is 190 pounds.
Po’s height is 60 inches.
Po's BMI is 37.10.

Po is obese.
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Example: Input q2b

Enter po's welght Enter po's height:

i

T

[ Preventihis page from creating addiional dialogs

[ ]

Example: Output g2b

Richard Rica
Po Body Mass I

This page will prompt Richard Ricardo for Kung Fu Panda Po's weight and height. The
program will convert the given input into Po's body mass index, and will inform Richard is Po
is overweight or underweight.

BMI = weight x 703 / height?

Weight in pounds. Height in inches.

If Po's BMI is less than 18. Po is underweight

If Po's BMI is between 18 and 24.9. Po has normal weight
If Po's BMI is between 25 and 29.9. Po is overweight

If Po's BMI is greater than 30. Po is obese

Click on the button below to enter Po's weight and
height.

| {Enter Richard's Po weight and height: |

Po's BMI:

Po’'s weight is 150 pounds.
Po's height is 69 inches.
Po’'s BMI is 22.15.

Po has normal weight.
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Question 3 — JavaScript Chapter 3 (35 points) Estimated time: 3 hours
Save question 3 files in subfolder “lastname_firstname_assignment4\q3\”.
Create a web page that displays the default information (example shown).
The initial page and related outputs should look like the examples shown below.
Create your page using “<your name>’s Employee Net Pay” as the page title. Save the page as index.htm.
Remember to document the html file with html comments.
Write a program that calculated an employee’s net pay.
o The program should prompt for
= Hourly pay rate
= Number of hours worked in a week
= Number of dependents claimed
o If the employee works more than 45 hours in a week, overtime is calculated at 1.5 times the
regular hourly rate.
o Taxes are then deducted from the gross pay as follows:
= No dependents: tax rate is 25%
= 1 to 3 dependents: tax rate is 20%
= 4 to 6 dependents: tax rate is 10%
= More than 6 dependents: tax rate is 5%
e Create a css file named style.css to format index.htm by creating your own layout (no two students should
have the same layout). Use css comments to document the css program.

Example: Initial Page

Richard Ricardo's Employee Net
Pay

This page will prompt Richard Ricardo to calculate an employee's net pay.
Richard Ricardo will be prompted for:

e Employee's hourly rate of pay;
o Number of hours worked that week;
o Number of dependents employee has.

Click on the button below to enter Richard's
employee pay information.

Enter Richard's employee net pay

Input g3a Output g3a and logic

Employee's hourly rate: $30. First 45 hours pay = $30 x 45 hours = $1350

Number of hours worked this week: 50 hours. Next 5 hours pay (overtime) = $30 x 5 hours x 1.5 = $225
Number of dependents: 3. Gross pay = $1350 + $225 = $1575

Tax rate for 3 dependents = 20%

Tax deduction = $1575 x 20% = $315
Net pay = $1575 - $315 = $1260

This employee earned: $1260 this week.

Input g3b Output g3b and logic

Employee's hourly rate: $40. First 40 hours pay = $40 x 30 hours = $1200

Number of hours worked this week: 30 hours. Next 0 hours pay (overtime) = $30 x 0 hours x 1.5 = $0
Number of dependents: 4. Gross pay = $1200 + $0 = $1200

Tax rate for 4 dependents = 10%

Tax deduction = $1200 x 10% = $120
Net pay = $1200 - $120 = $1080

This employee earned: $1080 this week.
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Example: Input g3a

Enter number of hours worked this week:

Enter employee’s hourly rate: §

[ Prevent this page from creafing additional dialogs

0K Cancel

Enter number of dependents:
[3 |
[ Prevent tnis page from creating additonal dialogs

oK Cancel

Example: Output g3a

Richard Rica
Pay

This page will prompt Richard Ricardo to calculate an employee's net pay.
Richard Ricardo will be prompted for:

* Employee's hourly rate of pay;
o Number of hours worked that week;
* Number of dependents employee has.

Click on the button below to enter Richard's
employee pay information.

Employee’s hourly rate: $30.

Number of hours worked this week: 50 hours.
Number of dependents: 3.

This employee earned: $1260 this week.
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Example: Input q3b

Enter number of hours worked this week:
EL

[ Preventtnis page from creating additional dialogs

Enter employee’s hourly rate: §

oK Cancel

Enter number of dependents.
4

[ Prevent this page from creating additional dialogs

3 Cancel

Example: Output g3b

Richard Ricar
Pay

This page will prompt Richard Ricardo to calculate an employee's net pay.
Richard Ricardo will be prompted for:

* Employee's hourly rate of pay;

o Number of hours worked that week;

* Number of dependents employee has.

Click on the button below to enter Richard's
employee pay information.

Employee’s hourly rate: $40.

Number of hours worked this week: 30 hours.
Number of dependents: 4.

This employee earned: $1080 this week.
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Important:

1. If you do not put <your name> / <your first name> in the above mentioned fields (as shown in the
examples), you will get 0 points for the question(s).

2. No two students should submit webpages with exactly the same code, or same content, or same layout, or
same color combination. If found, both students will get 0 points.

3. All html files must pass html validation at http://validator.w3.org/ without any error/warning (with only 1
warning). Use the validator’s “File Upload” tab to check each file.

4. When you view page source in a web browser, <!DOCTYPE html> must be at the top of every page. In
other words, all pages must be written in HTMLS5. (-20 points if not)

5. All css files must pass css validation at http://jigsaw.w3.org/css-validator/ without any error/warning.

6. All html (JavaScript) files must pass JavaScript validation at Firefox Web Console (Tools > Web
Developer > Web Console) without any error, without any warning.

7. If your html file contains any css component, your html file must pass both html validation (3 above), and
css validation (4 above) without any error.

8. If your files do not pass the validations, 2 points will be deducted for each error / warning found.

9. Document (comment) your html files (<!-- -->), css files (/* */), and JavaScript files (/* */).

Submission instructions:

e You need to test the above document(s) in your web browser.

o Do screen capture(s) of the initial page and the related output(s). Use any graphic editing software (e.g.
Microsoft Paint, Adobe Fireworks, GIMP, or Microsoft Expression Design etc) to cut out the browser
output (from the screen capture), paste them into a word document.

o For this assignment, you only need to do screen capture(s) of the initial page and the related output(s),
you do not need to do screen capture(s) of the input pages. Provide 2 different test cases for each question.
In other words, for each question, you need to have 1 initial page screen capture and 2 related output(s)
screen captures.

o Do screen capture(s) of html validation results and css validation results, cut and paste them into the word
document. You do not need to do screen capture(s) of JavaScript Lint validation results.

e  Save the word document as a pdf file.

You need to submit the following:
1. A pdf file containing the screen capture(s) of the web browser output (all html pages) and the screen
capture(s) of all html validation results (from http://validator.w3.org/) and css validation results (from
http://jigsaw.w3.org/css-validator/), name the file lastname_firstname_assignment04.pdf.
2. All html file(s), css file(s), and other related files (e.g. image files). Zip your file folder
(lastname_firstname_assignment4) into a single zip file (or rar file) lastname_firstname_assignment04.zip.
In the above example, the zip file should contain the following files and subfolders. If there is any image, there
should be a \images\ subfolder.

o lastname_firstname_assignment4\gl\index.htm
lastname_firstname_assignment4\gl\style.css
lastname_firstname_assignment4\g2\index.htm
lastname_firstname_assignment4\g2\style.css // you may put style.css in a subfolder
lastname_firstname_assignment4\g3\index.htm

o lastname_firstname_assignment4\q3\style.css
Please submit an electronic copy (the above mentioned two files: .pdf and .zip) to D2L digital dropbox.

Grading guidelines (programming questions):
Your programs will be judged on several criteria, which are shown below.
e Correctness (50%): Does the program compile (run) correctly? Does the program do what it’s
supposed to do?


http://validator.w3.org/
http://jigsaw.w3.org/css-validator/
http://validator.w3.org/
http://jigsaw.w3.org/css-validator/
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Design (20%): Are operations broken down in a reasonable way (e.g. classes and methods)?

Style (10%): Is the program indented properly? Do variables have meaningful names?

Robustness (10%): Does the program handle erroneous or unexpected input gracefully?
Documentation (10%): Do all program files begin with a comment that identifies the author, the
course code, and the program date? Are all the classes, methods and data fields clearly documented
(commented)? Are unclear parts of code documented (commented)? (Some items mentioned may
not apply to some languages)

A program that does not compile (run) will get at most 50% of the possible points.



